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Instructions

Complete this checklist for all PDF files that must be Section 508 compliant.

Instructions:

1.

6.

Type the full name of the document in the text box below.

Document Name*: QualityNet Contract Services:
Onboarding/Offboarding Procedures

Go to the first form field (requirement #1 Pass/Fail Status (All fields required*), and select
an option (Pass, Fail, or N/A).
Note: The status in the Pass/Fail Status column is required for all requirements.

Comments are mandatory for any requirements that fail. Comments are optional for any
requirements that pass or that are N/A.

Press the Tab key to move from field to field.

Save the completed checklist in the following format (the date is the date of the
compliance check):

508CKL_Filename_YYYYMMDD
Provide this checklist to the stakeholder.

FYI: The requirement descriptions for most of the requirements display the Web Content
Accessibility Guideline (WCAG), or success criterion, that applies to the requirement. WCAG
2.0 Level A and Level AA success criteria are incorporated by reference in the Federal
regulations that govern Section 508. Consequently, the WCAG Level A and Level AA success
criteria are in effect the Federal regulations for electronic documents. To learn more, see
Understanding WCAG 2.0.

Filename*: QNET_ContractSvcs_OnboardOffboard_Pro i
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Section 508 Compliance Checklist
for PDF Files

Table 1 — Best Practices

Requirement Pass/Fail Status Comments

(All fields required*) (Required only if Status is Fail)

1 Document Properties > Status*: pass Comments:
Description “Application” or
“PDF Producer” does not
display “Adobe LiveCycle
Designer”.

2 | Document Properties > Security | Status* Comments:
> “Content Copying for
Accessibility” displays “Allowed",
If the statement is false, the
security settings must be

updated.

" Pass

3 | The Accessibility Full Check Status*: pass Comments:
does not display Scripts —
Needs manual check under the
Page Content category. If the
statement is false, a Web and
applications checklist is required
to validate the content.

4 | Where no method exists to Status*: N/A Comments:|The subject document meets all
correct content so that it meets requirements. An alternate version
the requirements, an alternate iS not necessary.

version is provided. If the
statement is false, contact your
Section 508 program team for
alternate content options.

5 |Where the document links to or | Status*: N/A Comments:
embeds another file, an
appropriate checklist has been
provided for each link or
attachment.
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Table 2 — Text Alternatives (Non-Text Content)

Requirement Pass/Fail Status Comments

(All fields required*) (Required only if Status is Fail)

6 |Allimages and form image Status*: /A Comments:
buttons have appropriate,
concise alternative text. (WCAG
1.1.1)

7 |Images that do not convey Status®: pgss Comments:
content, are decorative, or with
content that is already conveyed
in text are changed to artifacts.
(WCAG 1.1.1)

8 |Equivalent alternatives to Status*: Pass Comments:
complex images are provided in
context or on a separate (linked
and/or referenced) page.
(WCAG 1.1.1)

9 |Images of text or that include Status*: N/A Comments:
text; e.g., logos, have the text as
part of the description.

(WCAG 1.1.1)

10 |All images or objects in the Status®: n/A Comments:
document have the Text Wrap
property set to In Line with
Text. (WCAG 1.1.1)

11 |Embedded multimedia is Status*: N/A Comments: |INo embedded multimedia is in the
identified via accessible text. document.
(WCAG 1.1.1)

12 | Animated content has an Status*: N/A Comments:

alternative or is described in
text. (WCAG 1.1.1)
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Requirement Pass/Fail Status Comments

(All fields required®) (Required only if Status is Fail)

13 |Mathematical formulas have an | Status*: N/A Comments:
alternative or are provided as
text. (WCAG 1.1.1)

Table 3 — Time-Based Media

Requirement Pass/Fail Status Comments

(All fields required*) (Required only if Status is Fail)

14 |Where media content is present | Status*: N/A Comments:
or embedded, the requirements
in the Time-Based Media
checklist pass. (WCAG 1.1.1
and 1.2.#)

Table 4 — Information and Relationships

Requirement Pass/Fail Status Comments

(All fields required®)

(Required only if Status is Fail)

15 |Yes is displayed next to Tagged | Status*: pgsg Comments:
PDF under Document
Properties > Description >
Advanced.

(WCAG 1.3.1and 4.1.1)

16 |Tags are used to structure Status™: p, g Comments:
content in a valid manner; e.g.,
a table is designated by a table

tag).
(WCAG 1.3.1and 4.1.2)

17 |Non-standard tags are mapped | Status*: N/a Comments: [No non-standard tags in the
appropriately in the Role Map. document
(WCAG 1.3.1 and 4.1.2)
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Requirement

Pass/Fail Status

(All fields required®)

Comments
(Required only if Status is Fail)

18

Tags are used appropriately to
designate headings; i.e., i.e.
<H1> - <H6>. (WCAG 1.3.1)

Status*

- Pass

Comments:

19

Heading tags are provided in
appropriate sequence (<H1>,
<H2>, <H3>, etc.).

(WCAG 1.3.1)

Status*:

Pass

Comments:

20

Tags are used appropriately to
structure Table of Contents lists
(STOC>, <TOCI>).

(WCAG 1.3.1)

Status*:

Pass

Comments:

21

Tags are used appropriately to
structure lists (a minimum of
<L> and <LI> are used).
(WCAG 1.3.1)

Status*:

Pass

Comments:

22

Tags are used and nested
appropriately to structure sub-
lists (a minimum of <L> and
<LI> are used).

(WCAG 1.3.1)

Status*:

Pass

Comments:

23

Tables are used for tabular
data. (WCAG 1.3.1)

Status*:

Pass

Comments:

24

Data table headers are
appropriately identified; e.g., TH
for simple tables and the
headers attribute for complex
tables. (WCAG 1.3.1)

Status*:

Pass

Comments:
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Requirement

Pass/Fail Status

(Al

fields required®)

Comments

(Required only if Status is Fail)

25

Data cells are associated with
their headers (ex. scope for
simple tables or headers and
IDs for complex tables).
(WCAG 1.3.1)

Status*

- Pass

Comments:

26

RowSpan or ColSpan is used
appropriately for merged cells.
(WCAG 1.3.1)

Status*:

N/A

Comments:

27

Tables are not used to construct
layout. Where tables are used
for layout purposes, and not
data, all table tags are removed
from the Tags structure.

(WCAG 1.3.1)

Status*

: Pass

Comments:

28

Form input elements have tool
tips that identify their purpose
and match the associated text
label. (WCAG 1.3.1)

Status*:

N/A

Comments:

No form input elements in the
document

29

Related form elements and
elements with multiple labels
are grouped appropriately; e.g.,
group name is identified as part
of the tool tip of the element;
radio buttons have the same
name. (WCAG 1.3.1)

Status*:

N/A

Comments:

Table 5 — Meaningful Sequence

30

Requirement

The reading and navigation
order (determined by
Show/Hide > Navigation Panes
> Tags) is logical and intuitive.
(WCAG 1.3.2)

Pass/Fail Status

(Al

Status*

fields required®)

:Pass

Comments

(Required only if Status is Fail)

Comments:|The technical writer inspected the

reading order manually and certifies
that it passes.
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Y — Pass/Fail Status Comments
q (All fields required*) (Required only if Status is Fail)
31 |All meaningful content appears | Status®: pggg Comments:
in the Tags pane.
(WCAG 1.3.2)
32 |Vital content from a header, Status*: N/A Comments:

footer or watermark is provided
in the document. (WCAG 1.3.3)

33 |Content that is repetitive or Status*: pass Comments:
decorative is changed to an
artifact. (WCAG 1.3.4)

Table 6 — Sensory Characteristics

. Pass/Fail Status Comments
Requirement

(All fields required*) (Required only if Status is Fail)

34 |Instructions do not rely upon Status*: N/A Comments: |Document contains no instructions
shape, size, or visual location;
e.g., "Click the square icon to
continue" or "Instructions are in
the right-hand column.”
(WCAG 1.3.3)

35 |Instructions do not rely upon Status*: N/A Comments:
sound; e.g., "A beeping sound
indicates you may continue."
(WCAG 1.3.3)
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Table 7 — Use of Color

. Pass/Fail Status Comments
Requirement

(All fields required*) (Required only if Status is Fail)

36 |Color is not used as the sole Status*: pass Comments:
method of conveying content or
distinguishing visual elements.
(WCAG 1.4.1)

37 |Coloris not used as the sole Status®: pgss Comments:
method to distinguish links from
surrounding text unless the
luminance contrast between the
link and the surrounding text is
at least 3:1 and an additional
differentiation; e.g., it becomes
underlined, is provided when
the link is hovered over or
receives focus. (WCAG 1.4.1)

38 |Non-text content; e.g., images, |Status*: N/A Comments:
uses patterns to convey the
same information as color.
(WCAG 1.4.1)

Table 8 — Audio Control

Y — Pass/Fail Status Comments
q (All fields required®) (Required only if Status is Fail)
39 | A mechanism is provided to Status®: N/A Comments:|No multimedia or animation is in the
stop, pause, mute, or adjust document

volume for audio from
multimedia or animation that
automatically plays for more
than 3 seconds. (WCAG 1.4.2)
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Table 9 — Contrast (Minimum)

. Pass/Fail Status
Requirement

(All fields required*)

Comments
(Required only if Status is Fail)

40 |Text and images of text have a |Status*: pagg
contrast ratio of at least 4.5:1.

(WCAG 1.4.3)

Comments:

Table 10 — Resize Text

. Pass/Fail Status
Requirement

(All fields required*)

Comments
(Required only if Status is Fail)

41 | The document is readable and | Status*: pass
functional when the text is set to

re-flow. (WCAG 1.4.4)

Comments:

Table 11 — Images of Text

. Pass/Fail Status
Requirement

(All fields required®)

Comments
(Required only if Status is Fail)

42 | The Scanned Page Alert does
not appear when the document
is opened and the Tools >
Accessibility > Full Check >
Document category does not
say Failed for Image-only PDF
or Tagged PDF. (WCAG 1.4.5)

Status*: Pass

Comments:

Filename*: QNET_ContractSvcs_OnboardOffboard Pro
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Table 12 - Keyboard Accessible

. Pass/Fail Status Comments
Requirement

(All fields required*) (Required only if Status is Fail)

43 | All document functionality is Status®: p55g Comments:
available (receives focus and
can be activated) using the
keyboard, unless the
functionality cannot be
accomplished in any known
way using a keyboard (e.g., free
hand drawing). (WCAG 2.1.1)

44 | All functionality of the content is | Status*: pgss Comments:
operable without requiring
specific timings for individual
keystrokes. (WCAG 2.1.1)

45 |Links are properly structured Status®: p5gg Comments:
using the <Link> tag with a
nested <Link-OBJR> tag.
(WCAG 1.3.1,2.1.1, and 4.1.2)

46 |Keyboard focus is never locked |Status*: pass Comments:
or trapped at one particular
document element. The user
can navigate to and from all
navigable elements; e.g.,
embedded objects, using only a
keyboard. (WCAG 2.1.2)

Table 13 — Enough Time

. Pass/Fail Status Comments
Requirement

(All fields required*) (Required only if Status is Fail)

47 |If a page or application has a Status*: N/A Comments:|No time limit in the document
time limit, the user is given
options to turn off, adjust, or
extend that time limit. This is
not a requirement for real-time
events (e.g., an auction), where
the time limit is absolutely
required, or if the time limit is
longer than 20 hours.

(WCAG 2.2.1)
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Y — Pass/Fail Status Comments
q (All fields required®) (Required only if Status is Fail)
48 | Automatically moving, blinking, |Status*: N/A Comments:|Document contains no moving,
scrolling, or auto-updating blinking, scrolling, or auto-updating
content (ex. multimedia, content

animation, etc.) that lasts longer
than 5 seconds can be paused,
stopped, or hidden by the user.
Moving, blinking, or scrolling
can be used to draw attention
to or highlight content as long
as it lasts less than 5 seconds.
(WCAG 2.2.2)

Table 14 — Seizures

. Pass/Fail Status Comments
Requirement

(All fields required*) (Required only if Status is Fail)

49 |No page content flashes more |Status*: py5g Comments:
than 3 times per second unless
that flashing content is
sufficiently small and the
flashes are of low contrast and
do not contain too much red.
(WCAG 2.3.1)

Table 15 — Navigable

. Pass/Fail Status Comments
Requirement

(All fields required*) (Required only if Status is Fail)

50 |The document has a Status*: pass Comments:
meaningful title indicating its
purpose under Document
Properties > Description > Title,
and Document Properties >
Initial View > Window Options >
Show is set to Document Title.
(WCAG 2.4.2)

51 | The navigation order of links, Status*: Pass Comments:
form elements, etc. is logical
and intuitive.

(WCAG 2.1.1 and 2.4.3)
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. Pass/Fail Status Comments
Requirement

(All fields required*) (Required only if Status is Fail)

52 |Keyboard focus moves to and | Status®: pggg Comments:
returns from elements
appropriately (ex. the opening
or appearance and closing of
dialogs).

(WCAG 2.4.4)

53 | The purpose of each link (or Status*: pass Comments:
form image button) can be
determined from the link text
alone, or from the link text and
its context; e.g., surrounding
paragraph, list item, table cell,
or table headers.

(WCAG 2.4.4)

54 | Links (or form image buttons) Status*: pgss Comments:
with the same text that go to
different locations are readily
distinguishable. (WCAG 2.4.4)

55 |Page headings and labels for | Status™: Nja Comments:
form and interactive controls
are informative. Avoid
duplicating headings; e.g.,
"More Details," or label text;
e.g., "First Name," unless the
structure provides adequate
differentiation between them.
(WCAG 2.4.6)

56 |Itis visually apparent which Status®: pgss Comments:
element has the current
keyboard focus (i.e., as you tab
through the page, you can see
where you are).

Filename*: QNET_ContractSvcs_OnboardOffboard_Pro 11
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Table 16 — Readable

Y — Pass/Fail Status Comments
q (All fields required*) (Required only if Status is Fail)
57 |Document Properties > Status*: p o Comments:
Advanced > Reading Options >
Language displays the

appropriate language for the
document. (WCAG 3.1.1)

58 | The language of page content | Status®: \/a Comments:Document is entirely in English
that is in a different language is
identified through Review >
Language > Set Proofing
Language. (WCAG 3.1.2)

Table 17 — Predictable

Y — Pass/Fail Status Comments
q (All fields required®) (Required only if Status is Fail)
59 |When a page element receives |Status*: Comments:
focus, it does not result in a Pass

substantial change to the page,
the spawning of a pop-up
window, an additional change
of keyboard focus, or any other
change that could confuse or
disorient the user. (WCAG
3.2.1)

60 |When a user inputs information |Status*: N/A Comments:
or interacts with a control, it

does not result in a substantial
change to the page, the
spawning of a pop-up window,
an additional change of
keyboard focus, or any other
change that could confuse or
disorient the user unless the
user is informed of the change
ahead of time. (WCAG 3.2.2)
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Table 18 — Input Assistance

Requirement Pass/Fail Status Comments
(All fields required*) (Required only if Status is Fail)
61 |Required form elements or form | Status®: \;a Comments:(Document contains no form
elements that require a specific elements

format, value, or length provide
this information as a text
description.

(WCAG 3.3.1 and 3.3.2)

62 |If utilized, form validation errors | Status*: N/A Comments:
are presented in an efficient,
intuitive, and accessible
manner. The error is clearly
identified, quick access to the
problematic element is
provided, and user is allowed to
easily fix the error and resubmit
the form. (WCAG 3.3.1)

63 | Sufficient labels, cues, and Status*: N/A Comments:
instructions for required
interactive elements are
provided at the beginning of the
form or set of fields via
instructions, examples, and/or
properly positioned form labels.
Note: Related fields need to
provide a group name, example
"Gender: Female". (WCAG
3.2.2)

64 |Ifaninput error is detected, Status™: n/a Comments:
provide suggestions for fixing
the input in a timely and
accessible manner.

(WCAG 3.3.3)

65 |If the user can change or delete | Status™: N/a Comments:
legal, financial, or test data, the
changes/deletions can be
reversed, verified, or confirmed.
(WCAG 3.3.4)
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Table 19 - Additional Iltems

. Pass/Fail Status Comments
Requirement

(All fields required*) (Required only if Status is Fail)

66 | The Accessibility Checker Status*: p55s Comments:
Inspection Results shows no
accessibility issues found.

67 | The document has been Status*: Pass Comments:
reviewed in Print Preview as a
final check.

Note: Ensure you update the
TOC following a Print Preview
as a Print Preview updates all
hyperlinks in the document and
resets the page number
hyperlinks.

Table 20 - Additional Comments and Recommendations

Additional Comments and Recommendations

Comments: |No additional comments

Note: The Technical Writer or Section 508 expert certifies that the checked document is Section
508 compliant as of the date of transmission to the stakeholder. Any changes made to the
checked document after transmission to the stakeholder may render the document non-
compliant for Section 508. In case of changes, return the document to the Technical Writer or
Section 508 expert for additional review to ensure its continued compliance.
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